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Senior SuccessFactors Consultant

SuccessFactors Experience: Since 2006

Lars Ole Dencker is a highly experienced consultant with 25+ 

years of experience with SAP HCM and SuccessFactors.  

Lars has worked with defining HR processes and 

implementing HR systems for 20 years with SuccessFactors. 

Lars holds a professional certification in both Perform & Align 

and Succession.
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Use Custom 
Attributes in 
Talent Search

SCM-20791

Users can now add 
custom attributes as 
search options in Talent 
Search, in addition to 
skills and competencies.

The level of impact is Medium

Enablement: Customer configured

Lifecycle: General Availability

Type: Changed
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Permission-Based 
Visibility of 
Performance Ratings 
in AI-Assisted 
Successor Insights

SCM-21577

As an administrator, you can 
now use role-based 
permissions to control the 
visibility of overall 
performance ratings in AI-
assisted successor insights, 
preventing sensitive 
information from being 
exposed to unauthorized 
users.

The level of impact is Medium. 
Requires AI Licenses.

Enablement: Engagement 

Executive or Account Manager

Lifecycle: General Availability

Type: Changed

On a position card in the Succession Org Chart or the Position 

Tile view, succession planners can leverage generative AI 

capabilities to generate insights into successors nominated for the 

position or the incumbent. Previously, the insights always display 

the nominees' latest overall performance ratings. Now, only 

succession planners with the User Permissions > Employee 

Data > Background Information permission for the element 

<sysOverallPerformance> can view those data of their target 

population. Ratings of users out of the target populations, as 

shown in the screenshot, are not available for AI analysis.
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Configure Goal 
Statuses That 
Don't Generate 
Home Page Cards

TGM-26781

In Admin Center Manage 
Templates, SAP introduced a 
new configuration setting 
named ‘Do Not Generate 
Cards on Home Page’ for 
Goal Management

The level of impact is High

Enablement: Customer configured

Lifecycle: General Availability

Type: New

Related to Customer Influence suggestions
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Automatic Archiving 
of Completed 
Development Goals

CDP-31288

As an administrator, you can 
now configure completed 
development goals to be 
automatically moved to a 
specified category, 
streamlining goal 
management for users.

The level of impact is High

Enablement: Customer configured

Lifecycle: General Availability

Type: New
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• A new switch, Allow users to manage learning without write permission 

for development goals, is available in the Career Development Planning 

Feature Settings admin tool. When enabled, users with read access to 

development goals and permission to manage learning can add learning from 

SAP SuccessFactors Learning or create and link custom learning to 

development goals. Previously, users needed write permission for at least one 

goal field to manage learning.

• This enhancement enables authorized users to align learning with 

development goals without violating compliance requirements, improving 

consistency between Learning and Career Development modules and 

reducing process gaps.

Manage Learning 
Without Write 
Permission for 
Development 
Goals

CDP-32106

You can now allow users to 
manage learning items in the 
latest Development Goals 
even when they have only 
read access to development 
goal fields.

The level of impact is Medium

Enablement: Customer configured

Lifecycle: General Availability

Type: Changed
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In the Career Development Planning Feature Settings admin tool, you can select a 

number-type custom field to represent the role level. Roles with a lower value than the 

employee's current role are regarded as lower-level roles and excluded from 

recommendations. The feature doesn't require pay grade configuration and supports 

organizations that use custom fields for role hierarchy. The custom field-based role level 

filtering applies to role recommendations in the following areas:

Suggested Roles in Legacy Career Worksheet

Latest Career Worksheet:

• "Personalized path" roles on the Career Paths tab of the Explore Recommended 
Roles page in Growth Portfolio

• Top Matches section on the Recommended Roles tab of the Explore 
Recommended Roles page in Growth Portfolio

Opportunity Marketplace when Suggested Roles is the role recommendation source:

• Explore Career Options section

• Recommended for You section in the Home tab of the SAP SuccessFactors app in 
Microsoft Teams

Exclude Lower-Level 
Roles from 
Recommendations 
Using a Custom Field

CDP-31601

As an administrator, you can 
now use a number-type 
custom field to define role 
levels, ensuring employees 
receive recommendations for 
roles at or above their 
current level.

The level of impact is High

Enablement: Customer configured

Lifecycle: General Availability

Type: New
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Improved Talent 
Card Editing 
Experience

TRVW-4655

You can now edit the section 
details of a talent card in the 
latest People Profile dialog.

Editing is not available for 
the Career Goals and 
Variable Pay History Data 
sections as they are not 
supported in the latest 
People Profile.

The level of impact is Medium

Enablement: Customer configured

Lifecycle: General Availability

Type: Changed
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View Team 
Skill Passions

CDP-28135

Managers can now view the 
top five skills and attributes 
their team members are 
most passionate about, 
including the number and 
name of team members 
interested in each skill or 
attribute.

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: New
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Search for and 
Link Assignments 
to Development 
Goals

OMP-5533

You can now search for 
assignments and link them to 
your development goals in 
the Linked Assignments 
section on the goal details 
page.

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: New



Other Release 
Features
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Minor Visual 
Changes in 1H 
2026

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed

KM-22133

SAP SuccessFactors made 
numerous minor visual 
enhancements in 1H 2026. 
The following enhancement is 
of particular note for 
Succession Management

Many less-visible 
enhancements have been 
made
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Consistent 
Growth Portfolio 
Landing Page

CDP-31570

The redesigned Growth 
Portfolio landing page is now 
automatically on when you 
enable the latest Career 
Worksheet and Opportunity 
Marketplace, regardless of 
users' permissions.

The level of impact is High

Enablement: Automatically on

Lifecycle: General Availability

Type: ChangedUsers who don't have Career Worksheet or 
Opportunity Marketplace permission can't see 
the Roles and Aspirations or Opportunities to 
Grow section on the Growth Portfolio landing page. 
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AI-Assisted 
Writing Now 
Available in 
Mobile Apps

MOB-87734

AI-assisted writing is now 
available in the mobile apps.

The level of impact is High. Requires AI 
Licenses

Enablement: Engagement 

Executive or Account Manager

Lifecycle: General Availability

Type: New

How It Looks Now
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The default width of the people selector has been adjusted, and 

any width changes are now retained and applied consistently.

Improved People 
Selector Experience 
in Goal Management

TGM-27793

SAP SuccessFactors enhanced 
the people selector on the Goal 
Management landing page with 
several usability improvements.

The level of impact is High

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed

A new control allows users to collapse or expand the people 
selector, and the system remembers its last selected state.
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Layout 
Improvements for 
Goal Management 
Pages

TGM-28076

SAP SuccessFactors has 
introduced layout improvements 
to the goal details, goal creation, 
and goal editing pages to 
provide a cleaner, more intuitive 
reading experience.

The level of impact is High

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed
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With this enhancement, the maximum number of goals that 

can be printed in a single request increases from 10 to 20, 

allowing users to include more goals in one print job.

This enhancement helps employees and managers prepare 

goal documentation more efficiently for performance 

discussions.

Print More Goals 
at Once in Goal 
Management

TGM-28131

Users can now print up to 20 
goals at once in the latest 
Goal Management.

The level of impact is High

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed
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The available job type in Scheduled Job Manager > Create Job Request is Migrate 

Development Goal Data to Reports. For better performance, it's recommended that 

you select one development goal plan template for each job.

This feature enables administrator self-service, reducing the need for support 

resources and increasing operational efficiency.

Role-Based Permission Prerequisites

You have the following permissions:

• Administrator Permissions > Admin Center Permissions > Monitor Scheduled Jobs

• Administrator Permissions > Admin Center Permissions > Manage Scheduled Jobs

Migrate 
Development Goal 
Data to Reports in 
Admin Center

CDP-31032

You can now create a one-time 
job request in the Scheduled 
Job Manager admin tool to 
sync data from reportable 
custom fields to Table and Story 
reports. 

Previously, the job could be 
created only in Provisioning.

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: New
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• When creating or editing Position Tile live slides in 

Presentations, users can now view and select 

values for Generic Object and Foundation Object 

filters. Previously, though appeared as filter 

options, they did not display values for selection. 

The filter options displayed in Presentations 

mirror the options you configured for the Position 

Tile View.

Filter Positions with 
Generic Objects and 
Foundation Objects in 
Position Tile Live Slides

SCM-21218

Generic Object and Foundation 
Object filters are now supported 
in Position Tile live slides within 
Presentations.

The level of impact is Low

Enablement: Customer configured

Lifecycle: General Availability

Type: Changed
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Inactive Job 
Roles Removed 
from UI

CDP-30303

Inactive job roles are now not shown 
on several Career Development user 
interfaces (UI), including both the 
legacy and latest Career Worksheet 
and Career Path.

In Career Worksheet, if an inactive job 
role is users' target role, the role still 
appears in the target role list, but users 
have the option to remove it. Here's a 
screenshot of the feature in the latest 
Career Worksheet.

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed
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Upcoming Role 
Available in Career 
Worksheet for 
Internal Hires

CDP-30340

When employees' job code changes 
in the system, the new job role is 
available both in the latest and 
legacy Career Worksheet. In the 
latest Career Worksheet, when 
employees open the Growth 
Portfolio, the new job role appears in 
the Roles and Aspirations section as 
"Upcoming Role," positioned after 
the current role and before any 
target roles. Employees can use a 
direct link to navigate to the role 
details page. All available actions for 
the upcoming role are the same as 
for target roles. 

The level of impact is Low

Enablement: Automatically on

Lifecycle: General Availability

Type: New
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View 
Employees' 
Role Details

CDP-28698

In Growth Portfolio > Team 
View > Summary, managers 
can not only see employees' 
current and target roles but 
also drill down to each role's 
details by selecting an 
employee name.

The level of impact is High

Enablement: Automatically on

Lifecycle: General Availability

Type: New
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View Full Job 
Profile for Job 
Roles

CDP-22199

To view the full job profile, select 
a job role and choose the link at 
the very end of the role 
description. 
The full job profile includes all 
available details such as 
responsibilities, required 
qualifications, relevant skills, 
and potential career paths.

The level of impact is Low

Enablement: Automatically on

Lifecycle: General Availability

Type: New
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• The target role is expanded by default with the skills and attributes information. You can change the 
setting under Choose a role to expand by default in Growth Portfolio > Roles and Aspirations in the 
Career Development Planning Feature Settings admin tool.

• This enhancement gives administrators flexibility to align settings with organizational preferences, 
improving the user experience for employees.

Configurable Default 
Expanded Role on 
Growth Portfolio 
Landing Page

CDP-29414

You can now configure whether 
the current role or target role is 
expanded by default in the 
Roles and Aspirations section 
on the Growth Portfolio landing 
page.

The level of impact is Medium

Enablement: Customer configured

Lifecycle: General Availability

Type: Changed
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Minor 
Enhancements 
to Career 
Development

CDP-31298

SAP SuccessFactors has made 
several enhancements to 
Career Development features, 
including Development Goals, 
Career Worksheet, and 
Mentoring.

The level of impact is Low

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed

Example:

Previously top 3 skills and no description of Role Readiness

Now, the section shows all skills and attributes employees have achieved and need to 

improve, and the Role Readiness link
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• These switches help administrators and compliance owners better meet regulatory and 

governance requirements by controlling the rollout and visibility of AI features, reducing 

user confusion and support requests.

Admin Switches 
for Disabling AI-
Assisted Goal 
Creation Options

CDP-31759

As an administrator, you can 
now control the visibility of the 
Create from Roles and Create 
from Interests options during AI-
assisted development goal 
creation.

The level of impact is Medium

Enablement: Customer configured

Lifecycle: General Availability

Type: New
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• The character limit for user input has increased from 200 to 500, allowing AI-

generated goals to better reflect complex objectives without being constrained 

by length.

•

This update improves the clarity and usefulness of AI-generated goals, 

helping users create actionable goals more efficiently and with less manual 

refinement.

Enhancements 
to AI-Assisted 
Goal Creation

TGM-28255

AI-assisted goal creation has 
been enhanced to produce more 
detailed and meaningful goal 
content.

The level of impact is Medium. 
Requires AI Licenses

Enablement: Customer Engagement 

Executive or Account Manager

Lifecycle: General Availability

Type: Changed
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The Include Linked Learning option appears selected by default in the Copy 
from Goal Plan dialog when both of the following conditions are met:

• Existing development goals contain linked learning.

• Users have permission to add or create learning.

Option to Exclude 
Linked Learning 
When Copying 
Development 
Goals

CDP-30343

When users create a 
development goal by copying an 
existing goal, they can choose 
not to copy linked learning by 
deselecting the option Include 
Linked Learning. Previously, 
linked learning items were 
always copied.

The level of impact is Low

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed
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When setting up open enrollment programs, administrators and program owners decide whether employees 

need approval to join as mentors and if so, whether such approval should come from administrators or 

managers. Previously, they couldn't change the mentor approval method for programs already in progress. 

Now, they can do so using the Require Mentor Approval (by mentoring program administrators or by 

managers) option in Manage Mentoring Programs:

• If they enable this option, new mentor requests require approval from the role they set.

• If they disable this option, the system automatically approves all pending requests.

• If they change the method from administrator approval to manager approval, managers receive 

notifications through email and on the home page.

• If they change the method from manager approval to administrator approval, administrators review 

requests themselves.

Change Mentor 
Approval Method 
for In-Progress 
Programs

CDP-29921

Mentoring administrators and 
program owners can now 
change the mentor approval 
method for open enrollment 
programs after launching the 
programs.

The level of impact is Medium

Enablement: Automatically on

Lifecycle: General Availability

Type: Changed



Deep Dive Topic 



A new permission User Permissions Succession Planners View/Add/Edit/Delete Successor 

Nominations has been added as a child permission under the Succession Planning Permission. You can 

use it to control who can manage successor nomination information.

To pair with it, in Admin Center Nominations Setup, a new option Apply target population restrictions 

to the View/Add/Edit/Delete Successor Nominations permission is available.By default, this option is not 

selected. Succession planners who have the existing Succession Planning Permission can nominate all 

active users in the system.

New Permission 
Control over 
Successor 
Nominations

SCM-21707

As an administrator, you can 
use role-based permissions to 
control who can manage 
successor nominations and who 
can be nominated as 
successors for positions or 
incumbents.

The level of impact is High

Enablement: Customer configured

Lifecycle: General Availability

Type: New



When these option are enabled, 

succession planners must have both 

the Succession Planning 

Permission and 

the View/Add/Edit/Delete Successor 

Nominations permission to nominate 

users. In this case, only users within the 

target population can be nominated as 

successors.

The following shows how the target 

population setting affects what 

succession planners with the new 

permission can do on the UI:

New Permission 
Control over 
Successor 
Nominations

On the position card, they can only view successors included in 
their permission role's target population. Successors outside 
this scope are hidden



On the talent card, they cannot view the current nominations or nomination 

history of users who are not included in the target population.New Permission 
Control over 
Successor 
Nominations



On the Nominations and Successors cards in the latest People Profile, or on the 

Current Nominations and Successors blocks in the legacy People Profile, 

nomination information for users outside the target population is hidden.

New Permission 
Control over 
Successor 
Nominations



When adding successor nominations on Succession module pages or from other 

modules integrated with Succession Planning, the nomination is not allowed if the 

nominees are not in the target population.

New Permission 
Control over 
Successor 
Nominations



Deleted and deprecated 
features



• The Spell Check feature is Deleted on  May 15, 2026.

• The legacy version of Goal Management will reach End of 

Maintenance on May 17, 2024, and will be Deleted on December 

31, 2026.

Deleted and 
deprecated 
Features

The level of impact is Low 

Enablement: Automatically on

Lifecycle: Deprecated/Deleted

Type: Changed



Product Road Map



Product Road Map

Click on the following link to 
access the Product Roadmap 
for Skills and Competencies 
Management.

Click on the following link to 
access the Product Roadmap 
for more SuccessFactors 
modules.

https://roadmaps.sap.com/board?range=CURRENT-LAST&PRODUCT=73555000100800000776
https://roadmaps.sap.com/board?PRODUCT=089E017A62AB1EDA94C15F5EDB3320E1&range=CURRENT-LAST#Q2%202026
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